This technical workshop

- Visualizing temporal data – recurring theme
- Managing temporal data
- Analyzing temporal data
- Building temporal visualizations
- Sharing temporal visualizations
ArcGIS 10.1 Themes

- Online
- Desktop
- Server
- Mobile
- Developer
- Solutions
Demonstration
Zebra Mussels, 1988-2008
Visualizing temporal data

### Dynamic
something that moves
- Planes
- Vehicles
- Animals
- Satellites
- Storms

### Discrete
something that “just happens”
- Crimes
- Lightning
- Accidents

### Stationary
stands still but records changes
- Weather stations
- Traffic sensors

### Change
change or growth
- Demographics
- Fire perimeter

Animated displays intuitively give the impression of change
Properties of time

• Time is linear
  - Wednesday always follows Tuesday

• Unidirectional
  - Events which happen today don’t affect yesterday

• Time can be cyclical
  - June 20th happens every year

• There are calendar and non-calendar based temporal measurement systems
GIS integration of time

Temporal visualization

New ways to manage, analyze, and visualize temporal data

Fixed time temporal data

Multidimensional (x,y,z,t)

Time stamps / time extents

Real-time sensor network

Mobile

Stationary

Analysis, simulation, & modeling

T1
ArcGIS built time into GIS

- **Time-enabled layers**
  1. Configure time properties on the layer
  2. Use Time Slider window to visualize the layer

- **Unified experience for time**
  - Works the same in ArcMap, ArcGlobe, and ArcScene
  - Part of Desktop, Engine, and Server products
ArcGIS built time into GIS, continued

- Geoprocessing (GP) tools
  - Data management
  - Time-aware analysis tools

- Ability to share
  - Layer and map packages
  - Map services for the web
  - Temporal map books
Demonstration

100 Largest Cities in the USA, 1790-2000
Managing temporal data
ArcGIS terminology

- **Time-enabled layer**
  - A layer that has been enabled to display time

- **Time stamp**
  - Value in the time attribute of the feature class, image, etc…

- **Time instant**
  - A single point on the timeline

- **Time extent**
  - Period of time between two points on the timeline
Tips for temporal data management

- Field formats
- Duration
- Time zones
- Daylight Savings Time
Store temporal data using the Date field type

- Store temporal data in a Date type field when possible
  - “Date” is a special field type specific to time
  - Only use String or Number field types if importing old data, or when Date won’t hold what you have
  - Convert the data, if necessary

- Index the Date field for faster display and query performance
Numeric and String formats

• Numeric
  - YYYY
  - YYYYMM
  - YYYYMMDD
  - YYYYMMDDhhmmss

• String
  - YYYY
  - YYYYMM
  - YYYY/MM/DD
  - YYYY-MM-DD
  - YYYY/MM/DD hh:mm:ss
  - YYYY-MM-DD hh:mm:ss
Numeric and String formats, continued

- Only “sortable” formats are supported
  - Numeric:
    - YYYYMMDD  20120730 > 20120830 = TRUE
    - MMDDYYYY  07302012 > 08302012 = FALSE

- Named Month strings are sorted alphabetically!
  - AUG-30-2012 will come before JUL-30-2012
What if your time is not in one of those formats?

✅ Use Data Management GP tools to convert to supported field types

- **Convert Time Field** GP tool - converts Numeric and String formats into a new Date field: “20120726” → 07/26/2012
  - Converts custom String formats into a new Date field: “July 26, 2012” → 07/26/2012
What if time is stored in columns?

- Use Data Management GP tools to convert to row format
  - Need to convert data with time in separate columns
  - **Transpose Fields** GP tool – shifts data entered in fields or columns into rows in a table or feature class
What if you want to imply duration?

✔️ Use Data Management GP tools to calculate end time
  
  • **Calculate End Date** GP tool - populates the End Time field with the next successive record’s Start Time
  
  • The last instance will not have a duration as the Start and End Time will be the same
What if your data reflects different time zones?

- **Standardize on UTC** or **GMT**
  - data is from multiple time zones
    - *Coordinated Universal Time*, **Greenwich Mean Time**
  - ArcGIS integrates data across different time zones
  - **Convert Time Zone** GP tool – converts between time zones
What if you are dealing with Daylight Savings Time?

- **Use Data Management GP tools to store temporal data as Standard Time (not DST)**
  - **Calculate Field** GP tool
  - **Problems with DST**
    - Regional differences
    - Political disagreement
    - Rules and boundaries change frequently
    - Some DST zones adjust less than an hour
      - 30 minute DST offset
      - 45 minute DST offset

*Source: Wikipedia*
Supported data

- Feature layers
- Mosaic datasets
- Raster catalog layers
- Tracking dataset layers with traffic data
- NetCDF (raster, feature, table)
- Network layers
- Video layers
Demonstration

Deepwater Horizon Oil Spill, 2010
Feature layers – Separate features

- The shape and location of each feature changes over time or the shape and location does not change.
- One table, features repeat for each time stamp.
- Row = feature + unique time stamp.
- Each row can also have an attribute value.
- Commonly used for capture or playback of moving objects (tracking).

```
<table>
<thead>
<tr>
<th>OBJECTID</th>
<th>Shape</th>
<th>Rank</th>
<th>Place</th>
<th>Population</th>
<th>X_coord</th>
<th>Y_coord</th>
<th>Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>870</td>
<td>Point</td>
<td>87</td>
<td>Akron, OH</td>
<td>42728</td>
<td>-81.5178</td>
<td>41.07315</td>
<td>1900</td>
</tr>
<tr>
<td>963</td>
<td>Point</td>
<td>81</td>
<td>Akron, OH</td>
<td>69067</td>
<td>-81.5178</td>
<td>41.07315</td>
<td>1910</td>
</tr>
<tr>
<td>1014</td>
<td>Point</td>
<td>32</td>
<td>Akron, OH</td>
<td>208435</td>
<td>-81.5178</td>
<td>41.07315</td>
<td>1920</td>
</tr>
<tr>
<td>1117</td>
<td>Point</td>
<td>35</td>
<td>Akron, OH</td>
<td>255040</td>
<td>-81.5178</td>
<td>41.07315</td>
<td>1930</td>
</tr>
<tr>
<td>1220</td>
<td>Point</td>
<td>38</td>
<td>Akron, OH</td>
<td>244791</td>
<td>-81.5178</td>
<td>41.07315</td>
<td>1940</td>
</tr>
<tr>
<td>1321</td>
<td>Point</td>
<td>39</td>
<td>Akron, OH</td>
<td>274605</td>
<td>-81.5178</td>
<td>41.07315</td>
<td>1950</td>
</tr>
<tr>
<td>1427</td>
<td>Point</td>
<td>45</td>
<td>Akron, OH</td>
<td>290351</td>
<td>-81.5178</td>
<td>41.07315</td>
<td>1960</td>
</tr>
<tr>
<td>1534</td>
<td>Point</td>
<td>52</td>
<td>Akron, OH</td>
<td>275425</td>
<td>-81.5178</td>
<td>41.07315</td>
<td>1970</td>
</tr>
<tr>
<td>1641</td>
<td>Point</td>
<td>59</td>
<td>Akron, OH</td>
<td>237177</td>
<td>-81.5178</td>
<td>41.07315</td>
<td>1980</td>
</tr>
<tr>
<td>1753</td>
<td>Point</td>
<td>71</td>
<td>Akron, OH</td>
<td>223019</td>
<td>-81.5178</td>
<td>41.07315</td>
<td>1990</td>
</tr>
<tr>
<td>1878</td>
<td>Point</td>
<td>97</td>
<td>Akron, OH</td>
<td>217074</td>
<td>-81.5178</td>
<td>41.07315</td>
<td>2000</td>
</tr>
<tr>
<td>17</td>
<td>Point</td>
<td>19</td>
<td>Albany, NY</td>
<td>3498</td>
<td>-73.7813</td>
<td>42.65982</td>
<td>1790</td>
</tr>
<tr>
<td>37</td>
<td>Point</td>
<td>17</td>
<td>Albany, NY</td>
<td>5289</td>
<td>-73.7813</td>
<td>42.65982</td>
<td>1800</td>
</tr>
</tbody>
</table>
```
Feature layers – Features joined to a table

- Features with one-to-one or one-to-many join
- The shape and location of each feature is constant but attribute values can change over time
- Commonly used with fixed position samples, such as weather stations and other sensor networks
Mosaic datasets and raster catalog layers

- Use a Date field
- Use an Index field (i.e., ObjectID)

Raster catalog layers will initially draw as a wire frame if there are more than nine rasters.
Tracking datasets – Use Tracking Analyst

- Tracks objects in real time
- Symbolize temporal data using time windows and other specialized options for viewing data that changes through time
- Play back temporal data using TA Playback Manager
- Analyze patterns in temporal data by creating data clocks
- Create and apply actions on temporal data
- Create animations of your data using TA Animation tool
Learn more!

Leveraging Temporal Data with ArcGIS Tracking Analyst and Esri Tracking Server
- Wednesday, July 25, 10:15 AM - 11:30 AM, Room 28 C
NetCDF layers and tables

- NetCDF – a file format for storing spatiotemporal data
  - Multiple dimensions (x, y, z, t)
  - Multiple variables (temperature, pressure, salinity, wind speed)
- Make a layers or tables for visualization and analysis using GP tools
Graphs

- Create a graph using a layer or table
- The graph will animate if the map is time-enabled
Text – Dynamic text

- Insert > Dynamic Text > Data Frame Time
- Layout view only
Text – Dynamic text

- Insert > Dynamic Text > Data Frame Time
Text – Time text

New Time Slider Window > Time Display tab > Show time on map display

- Data view or layout view
Time Slider Window > Time Display tab > Show time on map display
Demonstration
USA County Population, 1800-2000
Demonstration
USA Dams, 1800-2000
Dynamic timelines

- Constructed as geographic features
- A Date field is added and calculated
- Time is enabled on the appropriate layers
Example

Dam Construction, 1800-1840
Current date point / label and consecutive date fill are time-enabled

Background is not
Using the Fishnet GP tool

1 row, 200 columns (one for each year)
Analyzing temporal data
ArcGIS spatial statistics GP tools

- Existing tools that now incorporate space AND time
  - **Hot Spot Analysis** - identify statistically significant hot/cold spots in space and time
  - **Cluster and Outlier Analysis** - identify statistically significant spatial outliers in space and time

- New tool that allows space/time constraints
  - **Grouping analysis** GP tool
What's New in Spatial Statistics (three 20 minute sessions)
- Tuesday, July 24, 3:15 PM – 4:25 PM, Room 5 A/B

Spatial Pattern Analysis: Mapping Trends and Clusters
- Tuesday, July 24, 8:30 AM – 9:45 AM, Room 5 A/B
- Wednesday, July 25, 1:30 PM – 2:45 PM, Room 5 A/B
Building temporal visualizations
Tools to build temporal visualizations

- All these work with time-enabled layers
  - Time Slider window
  - Animation tools
  - Timeliner add-in

- Tracking Analyst
Time-enabled layers

- To visualize data interactively through time
- ArcMap, ArcScene, ArcGlobe
- Special effects with the Time Slider window
  - Time text
  - Time window
  - Time offset
  - Display data cumulatively
Demonstration
Atlantic Storms, 1995
Animation tools

- Animation toolbar
- ArcMap, ArcScene, ArcGlobe
- Use to create additional visual effects
  - Camera – Move camera along a path (fly-over)
  - Layers – Fade layers in/out with transparency
  - Map view – Pan/zoom
  - Visualize time-enabled data
Learn more!

Building 2D Animations
- Tuesday, July 24, 9:20 AM – 9:40 AM, Room 1 B
- Thursday, July 26, 4:05 PM – 4:35 PM, Room 3

Creating 3D Animations
- Tuesday, July 24, 9:30 AM – 10:00 AM, Exhibit Hall B
- Wednesday, July 25, 1:00 PM – 1:30 PM, Exhibit Hall B
Timeliner add-in

- arcgis.com > search for Timeliner
- http://www.arcgis.com/home/item.html?id=39458d01c4254bc8b34030cbcc2b2415
Timeliner

• Differs from Time Slider window
• Navigates from time-stamped data element to time-stamped data element without regard to fixed time period

👍 Great for sparse or temporally fragmented data
  - Events can be excluded interactively or based on an attribute
  - Multiple timelines can be named and saved for later use

• Works with feature layers, mosaic datasets, image service layers
• Field type must be Date
• Currently no export option, no support for end time field
Sharing temporal data
Sharing temporal visualizations

- Time-enabled layer and map packages
- Exports created using Time Slider window or Animation tools
  - Video – AVI
  - Sequential images – BMP or JPG
- Temporal map books created using ArcPy scripting
- Time-enabled web map services
Export sequential images
Time-enabled web map services

- View in ArcGIS Online and Explorer
- Create web maps or embed them in web map apps
- Playback controls added automatically
Review and summary
Review

- Visualizing temporal data
- Managing temporal data
- Analyzing temporal data
- Building temporal visualizations
- Sharing temporal visualizations
Summary of best practice recommendations

- Store temporal data in a Date type field when possible
- Index the Date field for faster display and query performance
- Use Data Management GP tools to
  - Convert to supported field types
  - Convert to row format
  - Calculate end time
  - Store temporal data as Standard Time (not DST)
Review - What’s new in ArcGIS 10.1?

- Visualizing data updates in live mode
  - Allows you to visualize the most recent updates to time-enabled data

- Time display improvements (time window, exclude start / end times)

- Add time text to data view and/or layout view

- Space-time analysis using GP tools
Please complete an online session evaluation
www.esri.com/ucsessionsurveys

1. My UC Homepage > “Evaluate Sessions”

2. Choose session from planner or search for session

ID for this session: 907
Questions?

Online session evaluation:
www.esri.com/ucsessionssurveys

Offering ID: 907